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Appendix A: Utilities and Maintenance

Damaged Database
Every once in a while you might find that one or more records in your CatBase

Data file have become corrupted. There are many things that can cause this to
happen, such as a hardware error (bad sector on your hard disk), power surge or
failure, and interference by some other program. You will find some suggestions
for avoiding trouble at the end of Chapter One.

4D Tools
We have provided a copy of a utility called 4D Tools to help you recover from

such problems. You’ll find it in the Utilities folder, which should be in your
CatBase folder (if it isn’t, you can copy it from your CatBase program CD).

Of course, prevention is always better than the cure, and you should always
make sure that you have current backups of your database. If you make a back-
up EVERY DAY that you make any changes to the database, the worst that can
happen is that you lose the current day’s work.

If you are using the multi-user version of CatBase, you will have received a
copy of 4DBackup. This is an EXTREMELY useful tool which maintains an ongo-
ing log of all modifications made to the database. If you have installed and set up
4DBackup, even the most disastrous disaster (such as your hard disk completely
dying) won’t put your database out of commission. You’ll be able to restore it
quickly, with very little or no loss of data.

If you are using CatBase Single-User, 4DBackup is not included but it can be
added on if you feel you would like the security it provides. Please contact
CatBase Software for more information.

4DBackup is described in more detail in the Administrator’s Handbook.
Note: DO NOT attempt to perform any of these tasks across a network! It will

take forever and the network will be tied up. 
To use 4D Tools:
➢ MAKE A BACKUP of your data file.
➢ Copy the 4D Tools application onto the hard disk that contains your

CatBase data file, if it is not already there.
➢ Make sure there is also a copy of the CatBase program on the same

hard drive.
➢ CatBase must not be running.
➢ Double-click on 4D Tools to launch it.
A file picker dialogue appears.
➢ Locate your CatBase program file and double-click on it. 
If you have more than one copy of your data file on your hard disk, you need

to make sure that you open the right one (the most current one). To do this:
➢ As soon as you double-click on the CatBase program file, hold down

the Alt (Option) key on your keyboard. 
The File Picker dialog will open up again. 
➢ Locate the current data file and double-click on it to open it.
There are two menus in 4D Tools: File and Utilities. Under the File menu is

one option, Quit, and under the Utilities menu are Check & Recover,
Compact, and Sort File.
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Check & Recover
Choose Check & Recover when you want to find out what’s wrong with

your database and repair it. When you choose this option you’ll see the following
dialogue box:

• Check only and create a log: If you choose this option, 4D Tools
checks the database to see where there is damage. A text file called
“Journal” is created on the disk. This file contains information describing
any damage that was found. Your database is not modified. You can open
the Journal file using any word processor and see which records or index-
es are damaged.

• Check and fix damaged records or indexes: This option also
checks the database for damage, and in addition repairs any damage that
is found. A text file called “Journal” is created on the disk. This file con-
tains information describing any damage that was found. After running
this option, it is advisable to run the Compact option. DO NOT interrupt
this procedure! Doing so will cause more damage to your database.

• Recover by Tags: This is a last resort and should only be used if you
have tried Check and fix damage but still have problems with your
database. This can happen when serious damage has occurred. When
you choose this option, 4D Tools creates a new database and copies the
data from the old one to the new one. Before starting this procedure you
must make sure that there is plenty of space on your hard disk (AT LEAST
the same amount of space as your data file currently occupies). When you
run this procedure, it is possible that some records will be lost (any that
were badly damaged), and some records that had been deleted may reap-
pear. DO NOT interrupt this procedure! Doing so will cause more damage
to your database. Running this procedure can take a long time (several
hours for a sizeable database). After the new data file has been created,
all the indexes will be rebuilt.

Compact
When you delete records from the database, they are not actually deleted;

they are marked within the database as deleted. This is not the same as when
you mark records for deletion in CatBase; in that event, the records are still live
and visible to you. It’s when you tell CatBase to delete the records (by choosing
Delete Records from Database from the Admin menu) that they disappear
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from the database. As new records are added, they fill the “holes” left where
records have been deleted. It’s a good idea to periodically compact the data-
base, especially if you have deleted lots of records. 

To compact the database:
• Make sure you have enough space on your hard disk for a copy of both

your program and data files.
• In 4D Tools, choose Compact from the Utilities menu.
A create-file dialog box is displayed.
• Enter a name for the new database.
• Click on the Save button.
4D Tools makes a copy of the database, compacting the data file in the

process.

Important Note: Sometimes when you are using 4D Tools to recover a corrupt-
ed data file, the progress indicator thermometer might take a long time before it
begins to show progress. This is to be expected: Don’t assume that your com-
puter has crashed! Give it plenty of time to do its job (this could be 30 minutes or
more).

After you have compacted the database, the next time you open your data file
all the indexes will be rebuilt. This is normal, and can take a little while if you have
a lot of data. DO NOT INTERRUPT THIS PROCESS!!!!! If you do, your database
will surely be damaged and you’ll have to go through the whole process again.

Sort File
Do not use this option! We have known it to cause serious damage to a

database.

Zap Table

Occasionally you may have the need to delete every record in the Companies
or Products table. You might need to do this if you are going to import a new set
of data from another system. We have provided an easy way to handle this task.

BIG WARNING NOTICE!!!!
This procedure will DELETE EVERY RECORD from the selected table!

➢ MAKE A BACKUP copy of your data file.
➢ Open up CatBase using the Administrator password. 
➢ Choose Zap Table from the Admin menu.
The following dialogue box opens up:
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➢ Select the radio button appropriate to the table you want to Zap.
➢ Click on the Delete Records button to zap the table, or on Cancel to

cancel the operation.
➢ If you clicked on the Delete Records button, you will be asked to

confirm that you want to PERMANENTLY DELETE all the records in the
selected table. Click on OK to continue, or Cancel to cancel.

➢ If you clicked on OK, all the records in the selected table are deleted.
IMPORTANT NOTE: If you Zap the Companies table, and you have your
database set up so that each Product record is required to have a
Company name entered, all the Product records will also be Zapped.
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Appendix B Troubleshooting

Error messages

File already open

You might see this message when you are trying to open a file such as an
import text file. It means that the file has not been closed properly, either
because it is still open, or there was some problem with it (maybe it was open in
another application, and that application crashed).. If it is a text file, you might
have it open in another program such as a word processor. If not, you will proba-
bly have to shut down the computer on which the file is resident and then reboot
the computer.

“Waiting to update the Company Record ...” 
This message could occur only in CatBase Multi-User. It might appear when

you are saving a new Product record. CatBase wants to update the related
Company record but can’t because another user has the required Company
record open. You must find out who has that Company record open and get them
to close it. Then CatBase will be able to make the required change. The other
person will be able to re-open the Company record.

General Problems

Memory
The cause of trouble you are most likely to encounter is a lack of memory.

CatBase needs AT LEAST 8 Mb of RAM to run properly. Solutions: 
1. Get more memory!
2. Install a memory-expanding utility such as RamDoubler.
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On Macintosh computers, simply installing more memory will not
necessarily mean that CatBase will be able to use it. You must let the
computer know that you want CatBase to be able to use more memory.
To do this:

Single-User
1. If CatBase is running, Quit.
2. Click once on the CatBase program icon. 
3. Choose Get Info from the File menu (Command-I).
The Info window opens up. It contains a Memory section, something like this:

(Yours may look different, depending upon the System version you’re using).
4. Increase the Preferred Size.
5. The Minimum Size MUST NOT be less than 8000! 
The Preferred Size is the amount of memory that you would like CatBase to

have each time it launches. However, if the specified amount isn’t available, it will
use whatever memory is available as long as there is at least the amount speci-
fied in the Minimum Size field. If the specified minimum amount of memory isn’t
available, you will see a message telling you that there is not enough memory to
run CatBase, and it won’t start up.

6. Close the Info window and start CatBase.

Multi-User
In the Multi-User version of CatBase, there are two parts of the program to

consider: the server and the workstations. You may need to assign more memory
to both the server and the workstations. Please see the Administrator’s
Handbook for a detailed discussion of memory in multi-user situations.

Searching

You have entered a record name into the Search Dialogue, and CatBase
does not find the record although you are sure it’s in the database.

• Make sure that you have not accidentally entered any extra characters,
such as a space in front of the word.

• Perhaps the database has become damaged. Try using 4D Tools (as
described earlier in this chapter) to  fix the problem.

Export Style Sheet Problems
Text is not formatted after importing into the page layout program
• You probably do not have the correct import filter installed. See the sec-

tion titled “Import Filters” in Chapter Nine. 
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• (QuarkXPress users) You did not check the Use Style Sheets check box
when importing the text into the page layout program. See Chapter Eight.

You have changed the specifications for a style sheet but the changes are not
reflected in your XPress document.

Once a style sheet has been established in an XPress document, its specifica-
tions will not be changed if the style sheet information is imported again, regard-
less of whether the specifications are the same or not. You need to either make
the same changes to the style sheet in the XPress document as you did in the
database, or delete the style sheet from the document. (Choose Style Sheets
from the Edit menu, select each style sheet name, and click on the Delete but-
ton.) When you import a file again, the style sheet will be re-created with the cur-
rent settings.

Syntax Error>

If you ever see a message like this, please take the following steps:
➢ Write down as much of the information displayed as possible.
➢ Call CatBase Software, or write, fax, or email us the information,

including details of what you were doing in CatBase at the time the
incident occurred.
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Appendix C Menu Bar Reference

Main Menu
The Main Menu is the first menu bar that you see when you start CatBase.

The choices available depend upon which access privileges you have been
given, and they are described in detail in Chapter Two, Setting Up Your Database.
Following are descriptions of the menu bars that are available when you are view-
ing or editing records.

Data Entry Menu Bar
When a data entry screen is displayed, this menu bar is available. Certain

options may not be available at all times.

File Edit
Save Undo
Cancel Cut
Quick Letter Copy
Memos Paste
Text Formats Clear
Quit Select All

Show Clipboard

File Menu 
Save: Saves the data displayed on the screen but does not close the record.
Cancel: Closes the record without saving any changes that were made.
Quick Letter: Opens the Quick Letter word processing add-on, if you have it

installed.
Memos: Opens up the Memos dialog box. From there you can view, edit, or

add Memos. Memos are explained in Chapter Three, Data entry.
Quit: This function is dimmed during data entry (not available).

Edit Menu
These are the standard data editing functions.

List Menu Bar
This is the menu bar that you see whenever you have a list of records dis-

played on the screen.
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File Edit Search Modify
Export … Undo Show Subset New Record
Chart … Cut Omit Subset Delete Selection
Label … Copy Show All Records Un-Delete
Quick Report … Paste Search Table Duplicate
Quick Letter Clear Search Selection
Memos ... Select All Search & Replace
Quit Show Clipboard Sort Selection

Show Products

File Menu
Export: This option is available only when you have a list of Companies,

Products, Style Sheets, Export Style Sheets or Categories displayed. You choose
Export … when you are ready to export data for creating your publication.
Exporting data is explained in detail in Chapter Nine.

Chart: This opens up the Graph Editor so that you can create graphs of your
data. It is explained in Chapter Five.

Label: Opens up the Quick Label Editor for creating labels. The Quick Label
Editor is explained in Chapter Five.

Quick Report: Opens up the Quick Report Editor, which you can use to design
columnar reports on your data. The Quick Report Editor is explained in Chapter
Five.

Quick Letter: Opens up the Quick Letter word processor, if you have it
installed. Quick Letter is an optional extra; contact CatBase Software if you
would like more information about it. You can find a Demo version (it is named 4D
Write) in the Demos folder on the CatBase program CD.

Memos: Opens up the Memos dialogue box. From there you can view, edit, or
add Memos. Memos are explained in Chapter Three, Data entry.

Quit: This function is dimmed (not available) when a list is displayed.

Edit Menu
Only Select All and Show Clipboard are available in a list view.
Select All: Selects all the records in the list.
Show Clipboard: Opens up a window that displays the contents of the

Macintosh Clipboard.

Search Menu
Show Subset creates a new list containing only the records you selected. This

becomes the current selection. 
Omit Subset creates a new list consisting of the list that was displayed minus

the line items that were selected. This becomes the current selection. If you start-
ed out with 20 items in the list, selected five of them and chose Omit Subset,
there would then be 15 items displayed.

Show All Records creates a list of all the records in the table.
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Search Table presents the Search Editor, which is described in Chapter Four,
Searching and Sorting. The search criteria that you enter will be used to search
all records in the table. This is not the same as Search Selection, which is
explained next.

Search Selection presents the Search Editor, which is explained in Chapter
Four. The search criteria that you enter will be used to search only the records in
the current selection. 

Search & Replace provides a utility to make global changes in your database.
This feature is described in Chapter Four.

Sort Selection presents the Sort Editor, which is explained in Chapter Four.
This lets you specify how you want the list sorted.

Show Products appears only when you have a list of Company records dis-
played. This menu choice lets you instantly see a list of products that belong to a
company. To use this option:

➢ Create a list of one or more Company records
➢ Click once on ONE company in the list.
➢ Choose Show Products from the Search menu.
CatBase creates a list of that company’s products and displays the list in a

new window. If no product records have been entered for the company, CatBase
will tell you so.

Modify Menu
New Record: Creates a new record for the current table. For example, if you

have a list of Product records displayed, choosing New Record will create and
open up a new Product record.

Delete Selection: Deletes the selected record or, in the case of Company and
Product records, marks the records for deletion by the System Administrator.
This is explained in detail in Chapter Four, Searching and Sorting.

Un-Delete: Restores records that had been marked for deletion. This function
is available only when a list of Company or Product records is displayed.

Duplicate: This option lets you make up to 99 copies of the selected record or
records.
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Appendix D Glossary

alert box: a dialogue box that notifies the user whenever an unusual situation
occurs. 

alphanumeric character: any character that is available on a regular keyboard.
Boolean: a true/false data type. A Boolean field can be displayed as yes/no,

or true/false.
button: an action object or “hot spot” on the screen: 

In addition to text, buttons can also contain pictures: 

Also see radio button.
choices: a field type in which you choose an entry from a pop-up list of pre-

defined choices. You can always recognise a choices field by the black arrow
next to the field:

client: in a multi-user environment, a workstation on the network.
Clipboard: a temporary storage area in the computer’s RAM for holding text or

graphics that you Cut or Copy from an application. 
Command key: Mac: The key on your keyboard with the cloverleaf and/or

Apple symbol on it.
compound search: A search in which more than one search criteria is entered.

See Chapter Four, Searching and Sorting, for more information. 
current selection: the group of records currently displayed in a list.
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dialogue box: a box containing text and, usually, a graphic that “pops up”
onto the screen and provides some piece of information to the user, or a selec-
tion of choices to be made. See alert box, request box.

delimiter: A special character that separates the parts of a text file so that
another application knows how to split the data up into the appropriate fields and
records when it is imported. The standard delimiters for Macintosh applications
are the Tab and Return characters. A Tab-delimited text file has a Tab character
separating each field and a Return character separating each record. On
Windows, the standard delimiter is a comma; each field is separated by quote
marks surrounding a comma, and each record ends with a Return character.
Note: There are variations on these themes!

export: the process of transferring data out of an application for use in anoth-
er application. 

Export Style Sheet: A special facility in CatBase in which you describe what
data you want to include in a publication, and how you want it to be formatted.

field: a particular type or category of information; for example, you enter com-
pany names in the Company Name field.

field delimiter: A special character that separates the fields of data in a text
file. See delimiter.

file server: see server
font: a type style. This text is in Helvetica Medium font.
import: the process of moving data created in one application into another. 
index: a table maintained by CatBase that keeps pointers relating to a particu-

lar field. See indexed field.
indexed field: a field which has been indexed. Searching and sorting on

indexed fields is much faster, as the program uses the pointers in the index to
locate the required record, rather than having to search sequentially for it.
Indexed fields are listed in boldface in lists such as search and sort dialog boxes.

IP address: Internet Protocol address. A set of digits that give a computer a
unique identity on a network or on the Internet.

memo: a mechanism through which you can set “reminders” for yourself or
other users. A Memo can be attached to a specific Company or Product record,
or may be free-floating. A Memo can also be either Public (anyone can view it) or
Private (only its owner can view it). Memos are explained in detail in Chapter
Three, Data Entry.

multi-user: A way of using CatBase which allows more than one person to
work on the data file at once. This uses special file-server software, 4D Server.

page: Each data entry window may consist of one or more pages, with each
page displaying different fields from the table. You move among the pages by
clicking on the tabs at the top of the page.

pixel: a “picture element” – one dot on the screen
point: the size in which a font is printed. This text is in the 12-point size.
pop-up menu: a menu within a window. It “pops up” into a full menu when it is

selected.
radio button: two or more options from which the user must make one (and no

more than one) selection, for example:
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RAM: Random Access Memory. The memory that your computer uses for
doing its work. Anything stored in RAM is lost when the computer is turned off. 

record: One complete set of information on a company, product, or other enti-
ty. The database consists of a number of records. Analogous to one card in a
card index. A record consists of a number of fields.

record delimiter: A special character that separates the records in a text file –
usually a Return character. See delimiter.

relation: A link between two tables in the database. There is a relation
between the Companies and the Company Contacts file, for example. This makes
it possible to export information on Contacts for a company when you are
exporting data. See Chapter Seven, Export Style Sheets, for a detailed explana-
tion of how CatBase uses relations.

request box: a dialogue box in which the user is required to enter a value.

selection: a group of records in a list that has been selected for viewing,
updating, duplicating, deleting, or some other operation.

server: a computer dedicated to running an application in a multi-user envi-
ronment. See Chapter 1 for more information.

simple search: A search in which only one search criterion is used, for exam-
ple, “Company Name starts with B”. See compound search. Searching is
explained in detail in Chapter Four, Searching and Sorting.
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subset: A selection of line items from within a list.
text field: A field into which text can be typed. 
table: That part of the application containing the information on one particular

aspect of the program. For example, all Company information is held in one table;
all Product information is maintained in another table. A table contains a number
of fields.

URL: Uniform Resource Locator. The location of an object on the Internet. The
Object can be a picture, web site, text file etc. It can be anywhere on the Internet
-- including your own computer or one on your network.

user: A person who has been entered into the CatBase database as a User
and given access privileges. See Chapter Two, Setting Up Your Database, for
more information.

user name: The name by which a user is known to CatBase. Your User Name
will be used when you create Memos or create or modify a Company or Product
record.

wildcard: The “@” sign is a wildcard character. You can use it in the Search
Editor to simplify data entry or to find a group of records that have something in
common. For example, if you build a search that reads “Company name is equal
to P@”, CatBase will find all company names that begin with a P. See Chapter
Four, Searching and Sorting, for more information.

workstation: a computer connected to a server via a Local Area Network. The
workstation accesses applications being run on the server.
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Appendix E. Tips and Techniques

Convert Quotes
When you import text into QuarkXPress or PageMaker you can tell the pro-

gram whether you want it to convert standard quote marks (the ones that look
like inch marks) into “smart quotes” (as used here). In both programs, this is
accomplished via the “Convert Quotes” check box in the Get Text (XPress) or
Place Document (PageMaker) dialogue. If the Convert Quotes check box is
checked (as it usually is by default), the page layout program will convert all stan-
dard quote marks into smart quotes as the text is imported. This is fine except
when you have text that includes actual inch marks; you don’t want your inch
marks converted into smart quotes! If this is the case, un-check the Convert
Quotes check box when you import text. 

If you use inch marks but you also use quotation marks that you DO want to
appear as smart quotes, you can handle the situation by entering the special
smart quote characters into the database instead of using the regular straight
quotes. 

On Macintosh, there are special key combinations to facilitate this:
To enter a left smart quote (“) type Option-[
To enter a right smart quote (”) type Shift-Option-[
To enter an apostrophe(’) type Shift-Option-]
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Appendix F: HTML Tags

Following is a brief listing of some basic HTML tags that you can use to for-
mat information in the headers and footers of your HTML exports. 

Most tags actually consist of a pair of tags: a starting and an ending tag. The
starting tag denotes the beginning of the formatting and the ending tag denotes
the end of it. For example, the tags for setting text in bold are <B> and </B>.

Headings:

You can select headings in sizes of 1 to 6, with 1 being the most important.
Browsers will display the headings in relation to their importance, with H1 being
the largest and H6 being the smallest.

Example:

<H1>This is the most important heading</H1>
<H2>This is a less important heading</H2>
<H6>This is the least important heading of all</H6>

will appear like this:

Text Formatting

Bold Text
Use the Bold tag to make certain words or phrases appear in bold. For exam-

ple:

Following is a list of our <B>most important</B> products!

appears as:

Italic Text
Makes text appear in italics. For example:

These products are currently available <I>only in the UK</I>.
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appears as:

Underlined text
Makes text appear underlined. For example:

These products are currently available <U>only in the UK</U>.

appears as:

Pictures
To place a picture, use the <IMG> tag:

This tag has only a starting tag -- no end tag. All of the necessary information
is contained within the tag. Various attributes can be included:

Attribute Meaning
SRC=”   “ The URL (name & location) of the image
ALT=”...” Alternative text to display
ALIGN=”   “ Alignment (left, centre, right, justify)
HEIGHT=”...” The height of the image
WIDTH=”...” The width of the image
BORDER=”...” Border width
HSPACE=”...” The horizontal space separating the image from other content
VSPACE=”...” The vertical space separating the image from other content

Example:
The HTML text:

<IMG SRC="Pictures/Special banner.jpg" HSPACE="4">

typed into the Header area of an Export Style Sheet will produce the following
result:

The “special offers” banner is a picture called Special banner.jpg, which is locat-
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ed in the Pictures folder.

Links
You can use the HREF tag to create a link to a URL anywhere on the Internet,

your office intranet, or even simply to another document on your computer.

For example, the following line inserted into the Footer section on an Export
Style Sheet:

<H5>These pages were built by <A HREF="http://www.catbase.com">CatBase</A>

produces the following result:

You can use this tag to include links to companies’ web sites when you export
data to HTML documents. The following illustration shows how to set up five
Elements to include a link to each company’s web site, if there is an entry in the
Web Site field:

(This example is from the Products for Web Export Style Sheet example in the
Demo database).

If a company does have a web site, CatBase will produce a line of code like
this:

Web site: <A HREF="http://www.catbase.com/">http://www.catbase.com</A>

which will appear like this in a web browser:
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